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Class #24: Transient Simulations and Voltage Follower Circuits 
 
 

Purpose: In this experiment, we will use simulation software (LTspice) to study transient responses using ideal 
models. We will also introduce the amplifier circuits used for isolation (voltage follower circuits). 
 
Background: Before doing this experiment, students should be able to 
 Review online background materials. 
 Build and operate simple circuits on a Protoboard. 
 Analyze circuits consisting of combinations of resistors, capacitors and inductors. 
 Do a transient (time dependent) simulation of circuits using LTspice 
 Review the background for the previous experiments. 
 
Learning Outcomes: Students will be able to 
 Implement transient simulations on LTspice and extract waveform characteristics from measured results. 
 Build a voltage follower amplifier circuit and verify that it will not affect circuit characteristics. 

 
Resources Required: 
 LTspice 
 M1K board and Alice tools 
 Parts kit 
 
Helpful links for this experiment can be found on the course website under Class #24. 
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Part A – Transients in LTspice  
 
Background 
 
We have used LTspice to simulate the DC bias points of circuit (operating point, .op).  In this experiment we will use 
LTspice to simulate circuits with voltage and currents that vary with time. This analysis is called transient simulation, 
which is a fundamental part of engineering modeling. In the last two experiments, we have used resistors, capacitors 
and inductors. In LTspice, we are familiar with the placing resistors on the schematic. Capacitors and inductors are 
also available as hotkeys, to the ‘right’ of the resistor hotkey, as seen in Figure A-1. Since our voltage source in the 
last two experiments also has transient characteristics (changes with time), we will also need to step up “Advanced” 
voltage sources. Once the circuit is complete, a transient simulation must be setup. The example below shows a 
transient simulation that runs from 0 to 5ms with a maximum step size of 1µs. Once the simulation is run, it displays 
an output similar to what you would see if you hooked the circuit to an oscilloscope.  Figure A-2 contains a sample 
diagram. 

 
 

Figure A-1. Simple Circuit with Sinusoidal Voltage Source 

 
Figure A-2: Transient Voltage across the Resistors. 
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Experiment (Simulation) 
 
Opening a New Simulation 
In this part of the experiment, we will simulate a familiar voltage divider circuit. 
 
Drawing the Circuit 
Figure A-3 is a picture of the LTspice IV main screen with the circuit we will be drawing.   
 

 
Figure A-3. Voltage Divider Circuit 

 
 Simulate the circuit shown in Figure A-3, setting the values of the resistors and remembering to include the 

ground node. 
 Right click on the voltage source. Rather than setting a DC value for the source, click the Advanced Button. 

A screen similar that shown in Figure A-4 will open.  
 We will initially be studying sinusoidal sources, so click on the SINE radio button. More setting options will 

now be available. We will keep the configuration fairly simple and only set the amplitude (to 4V) and the 
frequency (to 1kHz). The DC offset will automatically be set to 0V.  

   
Figure A-4. Sinusoidal Voltage Source Options 
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The circuit will now appear as shown in Figure A-5 

 
Figure A-5. Fully Implemented Circuit with Sinusoidal Source 

 
Setting Up the Analysis 
After we have defined all the components, wired them up and changed their values appropriately, we are ready to do 
some analysis.  
 Find the Simulation drop-down menu and click and select Edit Simulation Cmd.  You will get the window shown 

in Figure A-6. Select the tab for the type of analysis you wish to perform. In this case it is Transient since we are 
interested in output that is time-dependent like a scope. The simulation will begin at time t = 0, but we can choose 
to start saving data after that. Thus, we specify the Stop Time (the end time of the simulation), the Time to Start 
Saving Data, and the Maximum Timestep (the resolution of our simulation). It is important to choose a 
maximum time step much less than the period of the signal. Here we choose, 5ms, 0 and 1µs, respectively. 
Note that there is no µ so we have to use the letter u.  

 
Figure A-6. Simulation Settings 
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The final time (Stop Time:) has been set at 5ms because the period of a 1kHz sine wave is 1msec.  This allows us 
to see five periods.  The Maximum Timestep needs to be set so that you get a reasonable representation of the 
output.  A step size that is too small will take a long time to run, a step size that is too big will give you an under-
sampled representation of the output.  A step size between 1/100 to 1/1000 of the run time is reasonable.  The 
analysis will begin saving data at 0 seconds.  Note again that there should never be any spaces between the number 
and its units.  Click on the OK button when you are finished putting in the numbers.  You will be able to place 
the information on the simulation anywhere on your circuit. Choose a space where it is easy to read and does not 
block anything else. 

 When you have finished, you can run the simulation either by pushing the button that looks like a stick person 
running or select Run from the Simulation drop-down menu.  
 

Transient Analysis 
You are now ready to do the simulation.  
 
 Click on the Run button.  A set of axes with no signals shown will appear. You can now add voltages wherever 

you wish by left-clicking with your mouse. You will see that whenever you hover over a wire with your mouse, 
a symbol like a voltage probe will appear. Click where you want to know the voltage. If you want to plot current, 
hover over a device symbol and your mouse symbol will change to a current probe. If you click on a device, the 
current through it will appear on the plot. In the plot shown in Figure A-7, the input and output voltages for an 
example voltage divider are displayed.  

 You should get something like (but not identical to) results in Figure A-7. The voltage divider expression we used 
in the previous classes can be applied to sinusoidal signals as well. For sinusoidal signals, the amplitude of the 
sine wave changes based on the voltage divider ratio. We can then perform the same comparison between source 
voltage amplitude and resistor voltage amplitude as we did in experiment 7 where we compared the source DC 
voltage and the resistor DC voltage. For your voltage divider circuit, do we see the same ratio of voltage 
amplitudes as seen for DC voltages in experiment 7? 

 It is useful to know how to copy plots and paste them into word.  Click on (highlight) the window with the 
transient plots. Under the Tools menu, click on “copy to clipboard”.  Now there is a bitmap in the clipboard that 
you can paste into any application.  Open word and paste the bitmap in should see a plot of the voltages. You can 
do the same thing with the schematic window. 

 In your report, include the schematic, source voltage and VR2 for your voltage divider circuit. 
 

 
Figure A-7. Source Voltage and VR2 Voltage 
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 Right click on the voltage source, click the Advanced button, and change the type of source to 

a square wave using the PULSE radio button.  
 We will generate a square wave pulse with a 1kHz frequency (1ms period), maximum voltage 

of 2V, minimum voltage of 0V and 50% duty cycle (half the time vmax, half the time vmin). 
To make LTspice behave well, we will also need to set up some of the other options. The full 
setup is shown in Figure A-8. 
In the settings for the PULSE square wave, the boxes have the following application 
 Vinitial: Either the maximum or the minimum voltage (whichever Von is not) 
 Von: Either the maximum or the minimum voltage (whichever Vinitial is not) 
 Tdelay: Time delay, very small for our purposes 
 Trise: Rise time, very small for our purposes 
 Tfall: Fall time, very small for our purposes 
 Ton: The amount of time the pulse is high, half the period for a 50% duty cycle 
 Tperiod: The total time for one cycle, 1/f 
 
 

 
Figure A-8. Square WaveVoltage Source Options 

 
 Using the same simulation profile, run the simulation with the square wave source. Is the output again consistent 

with the expected results for the voltage divider? 
 In your report, include the schematic, source voltage and VR2 for your voltage divider circuit. 
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Part B – RC, RL and RLC circuits 
 

 Using the PULSE setting for the voltage source, implement the RC circuit shown in Figure B-3 of experiment 
22.  

 Plot the voltage across the capacitor. Is the plot similar to that seen when using the M1K Board? 
 Pick two points on the plot when the voltage is decaying to zero and estimate the time constant using the 

formulat 2 1

2

1

ln

t t

V

V

 
 

 
 
 

 (the  inverse of the attenuation constant equation from the last experiment). Is the 

estimated time constant close to the expected value? 
 
 

 Repeat the above for the RL circuit from experiment 23 when R = 470Ω. You will need to change your 
voltage source period and on-time based on your CH A function generator settings. You will also need to 
change the simulation settings stop time such that you can see five periods in your measurements. You should 
also  modify your step size. In this case, measure the current through the inductor instead of the voltage across 
the resistor. Use the same transient calculation as above to estimate the time constant, replacing voltage 
values with current values. Are the results again consistent with the calculated time constant? 
 

 Repeat the above for the RLC circuit from experiment 23 when R = 10Ω. You will again need to modify 
your voltage source settings and simulation settings based on your experiment 23 CH A function generator 
settings. In this case, you should set the simulation settings such that you can clearly see the decaying sinusoid 
rather than seeing five cycles of the source frequency.  
 

 Using the same process in experiment 23, estimate the oscillation frequency and attenuation constant using 
your plot results. How do those values compare with the experimental estimates? Why is it important that we 
have a thorough understanding of our components and equipment when we implement simulations? 
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Part C – Isolation Amplifiers (Voltage Dividers) 
 
A new component we will introduce is called an amplifier circuit. There are many applications for amplifier circuits. 
We will implement a voltage divider circuit, which is used to ‘measure’ voltage without interfering with the regular 
operation of the circuit. An amplifier is an active device, which means it needs power (voltage sources) to work 
correctly. The circuit we will implement is shown in Figure C-1. 
 

 
Figure C-1. Basic Voltage Follower Circuit 

 
 An operational amplifier is a two input (shown on the ‘left’ flat side of the device), one output (shown on the 

right ‘triangle point’ of the device) component. In many operations, the circuit involves feedback from the 
output to the input. The feedback will always be connected to the negative input. In this circuit, the feedback 
consists of a wire connecting the input and the output. 

 Find the AD8542 amplifier chip surface mounted on a small PCB in your parts kit and place it on your 
protoboard. Make sure the chip spans the chip gap such that the legs on each side are in separate 5-hole rows. 
There should be four legs on one side of the gap, each in a different row and four legs on the other side of 
the gap.  
 

 
 The physical layout of the chip is shown in Figure C-2 below. Identify the pin numbers 1 to 8 on the AD8542 

board by finding pin 1 and counting clock-wise all the way to pin 8. Pin 1 and 8 are marked on the board as 
shown above.  

o Connect CH A (function generator) from M1K to positive input pin 3 of the chip (labelled in Figure 
C-2). 

o Connect the output pin 1 to the negative input pin 2 of the chip using a wire. That is the feedback 
wire from the output to the input, shown in Figure C-1. 

o Connect the +5V voltage supply from M1K to pin 8 of the chip. 
o Connect the GND from M1K to pin 4 of the chip. 
o Connect Ain from M1K to pin 3 to measure voltage waveform supplied by CH A. CH A needs to 

be configured in Split I/O mode.  
o Connect Bin from M1K to pin 1 to measure output voltage waveform. Channel B needs to be 

configured in Split I/O mode. 
o Connect a 1MegΩ resistor from the output pin 1 to ground. (This step is not really necessary since 

the M1K board voltmeter acts like a 1MegΩ resistor.) 

Pin 8 

Pin 1 
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Figure C-2. AD8542 Chip Layout 

 
 Configure CH A to generate a 1kHz, 1V amplitude, 1V offset sinusoidal wave. i.e. 

sin(2 × 𝜋 × 1000 × 𝑡) + 1. In other words, Min = 0 V, and Max = 2 V. Frequency = 1000 Hz.  
 Measure the function generator voltage using Ain and the amplifier output using Bin as described 

earlier. Display 2-3 cycles of both input and output voltage measurements on Alice desktop. Adjust 
V/div and ms/div for appropriate horizontal and vertical scaling of the oscilloscope view.   

 If everything is working correctly, the input and output voltage waveforms should be the same. 
 Capture the image of the voltage measurements and put it in your report.  

 

 
Figure C-3. Experiment 19 B-3 RC Circuit with Voltage Follower 

 
 Add the resistor and capacitor values from experiment 22 B-3 circuit to the circuit you just built, as shown 

in Figure C-3. You will need to remove the CH A from the op-amp chip and connect it to the resistor as 
shown. The capacitor node is now connected to the positive input (pin 3 of the chip). 

 Measure the function generator voltage using Ain and the amplifier output using Bin from M1K.  
 The output voltage should be the same as you saw in experiment 22. 
 Capture the image of the voltage measurements and put it in your report.  

 
 


